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Introduction 
Congratulations on the purchase of 

your new F-920 Check It! Gas 

Analyzer.  

The F-920 Check It! Gas Analyzer is 

designed for continuous or spot 

measurement of carbon dioxide 

(CO2) and oxygen (O2) in 

headspace gas. The Check It! 

rapidly measures O2 and CO2 from 

0-100% for fast and accurate 

sampling of sealed packages or 

open atmosphere. The built-in data logger stores thousands of 

data points and conveniently communicates data through USB 

or Bluetooth onto a PC or tablet for later analysis. Each data 

point records concentrations of O2 and CO2, flow rate, 

temperature, relative humidity, GPS location, date and time. 

Controller software for easy calibrating the F-920 is available for 

download at www.felixinstruments.com. 

With its rapid response time and lightweight handheld profile, 

the F-920 provides a fast, portable verification process for 

atmosphere quality control. Easy to use straight out of the box 

with little or no training, the F-920 is ideal for verifying CO2 and 

O2 levels in Modified Atmosphere Packaging (MAP) applications, 

packing lines, laboratories, import/export surveys, distribution 

centers, retail centers, storage facilities, ripening rooms and 

shipping containers.  

We hope you enjoy using your F-920 Check It! Gas Analyzer. 

http://www.felixinstruments.com/
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Features & Specifications  
The F-920 features include: 

 Measurement of CO2 and O2 concentrations from 0-

100%  

 Results are displayed in 6-9 seconds  

 Previous records available for review on device  

 Handheld and lightweight (less than 1 kg) 

 Battery lasts for 8+ hours  

 Sunlight-visible transflective LCD display easily viewed 

in any environment  

 Functional across broad temperature and humidity 

ranges  

 Bluetooth enabled for rapid data transfer 

 Controller software for easy calibration available online 

F-920 Specifications 

Air Sampling Rate 70 mL/min 

Measuring Rate 
Automated, 1 second intervals to SD 
in Continuous Mode 

Data Storage Removable 4 GB SD and Bluetooth 

Display Sunlight visible transflective LCD 

Operating environment 
0°C - 45°C (0-90% relative humidity, 
non-condensing) 

Power Source 
Removable rechargeable lithium-ion 
battery 

Dimensions 18cm x 13.5cm x 5.5cm 

Weight 0.95kg 

Enclosure Powder coated aluminum 

Warm-up time < 3 minutes 
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Sensors 
Carbon Dioxide (CO₂) 
SENSOR Infrared sensor, pyroelectric detector 
Nominal Range 0-100% 

Full Scale Resolution  0.01% absolute 

Accuracy – Trigger 
Mode 

±.5% absolute and ±3% of measured 
value 

Accuracy – Continuous 
Mode 

±.01% absolute and ±3% of measured 
value 

Lower Detection Limit .01% 

Sampling Time 10 seconds 

Zero Interval Weekly 

Calibration Interval 12 Months 

Lifetime 5 years 

  

Oxygen (O₂) Sensor Electrochemical 

Nominal Range 0-100% 
Full Scale Resolution  0.1% absolute 

Accuracy – Trigger 
Mode 

±0.3% absolute and ±2% of measured 
value 

Accuracy – Continuous 
Mode 

±0.1% absolute and ±2% of measured 
value 

Lower Detection Limit 0.1% 

Sampling Time 10 seconds 

Zero Interval Weekly 

Calibration Interval 6 months 

Lifetime 2 years 

Unpacking the F-920 Check It! 
The F-920 arrives with a hard-sided carrying case, two sets of 

batteries and a charger, a removable 4 GB SD card, and several 
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accessory parts. A sampling port with needle is included for 

taking non-destructive samples from packaging. The sampling 

port is pictured below, connected to the intake. 

 

Operating Instructions 
WARNING: Spring-loaded battery cartridge 

Loading the Battery 
The F-920 uses 18650 Li-ion 3.7V 

3100mAh rechargeable batteries. For 

longer lifespan, charge the batteries at 

0.25A. For a faster charge, charge at 

1A. The batteries must be removed 

from the F-920 to be charged. If the 

batteries of the F-920 discharge during 

storage, replace with charged batteries. 

The Li-ion batteries have little self-

discharge and a lifetime of ~ 3 years.   
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To remove the batteries, twist the battery compartment cap, 

located on the bottom of the case. The cap can be twisted with 

fingers or a screw-driver to tighten or loosen it. Take care when 

removing batteries, as the cap is spring loaded. Both batteries 

should be inserted into the unit positive (+) side first (towards 

intake or top). 

Additional button-top 19670 (or protected 18650) batteries can 

be purchased from your preferred battery vendor if 

replacements are needed. 

 

Basic Operation 
To turn the instrument on, press the green power button. The 

current version of firmware the unit is running is displayed in 

the lower Left hand corner.  

For information on the latest firmware version, please visit the 

F-920 support webpage: www.felixinstruments.com/support/F-

920. 

The battery meter is listed on the lower right hand side of the 

display. 

The main menu displays the following options: Measure, Setup, 

and File. If the power button is pressed, the display will prompt 

for confirmation before shutting down the F-920.  

To scroll between menu 

items in the list, use the Up 

and Down arrows. To select 

an option from the menu 

list, use the Right arrow. To 

exit, use the Left arrow.  

Felix Instruments 

Measure  
Setup 
File 
F-920 Vx.x.x.x 

http://www.felixinstruments.com/support/F-920
http://www.felixinstruments.com/support/F-920
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Measurement Modes 
Two measurement modes are incorporated into the F-920 

Check It! 

 Continuous mode 

 Trigger Mode 

Continuous mode measures the air entering through the input 

of the instrument. Continuous mode can be used with or 

without the sample port attached to the front of the 

instrument. Data is saved to a file every one second on the F-

920. 

Trigger mode measures the air entering through the input of 

the instrument. The pump will run and the sample will enter 

until a stable reading has been achieved. The final values will be 

displayed on screen and saved to the SD card. The pump will 

then turn off until the user initiates a new measurement. 

Trigger mode can be used with or without the sample port 

attached to the front of the instrument.  

To change between modes, Navigate to Setup > Mode from the 

main menu. 

Measure 
From the main menu, press the right arrow when the word 

‘Measure’ is highlighted to enter the measurement display 

screen. All measurement parameters are saved to the SD card 

every 1 second in continuous mode. When the SD card is not 

present, the data will not be saved. The unit also comes 

equipped with Bluetooth technology, designed for wireless 

transfer of data (see Transferring Files, page 15). 
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If sampling very high concentrations followed by very low 

concentrations, allow the instrument to purge internal gas for 

the most accurate measurements.   

Continuous Mode 
When in continuous mode, a graph of the concentration of each 

gas can be viewed over time. The default graph shown is the O2 

concentration in ppm. To view the CO2 graph, simply use the up 

and down arrows to scroll through the graphs. The current gas 

being graphed is shown on the top of the screen with the 

concentration in large font as shown below.  

 

The x-axis of the graph is time. The y-axis of the graph displays 

the range of the concentration in % for CO2 and O2, and the 

dynamic range is labeled at the top. The y-axis scale is set by the 

highest value shown in the buffer.  

The graph begins on the Left side and moves towards the right 

as more data points are added. The total measurement time is 

displayed below the graph. The flowrate (mL/m) is displayed at 

the bottom.  

Trigger Mode 
A measurement in trigger mode will initiate a small volume 

sample taken over several seconds until the reading is stable. To 

begin, press the square start button as prompted to measure. 
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This will turn on the pump before drawing in sample gas. Trigger 

mode will take longer to stabilize if the concentration is in a 

different range from the last sample.  

 

 

The results will be saved to the SD card. Press the square start 

button to begin another measurement. Press the Left arrow to 

exit to the main menu.  

Taking a Measurement 
Assemble the probe and connect the needle probe tubing to the 
intake of the F-920. Twist on a hydrophobic filter to the end of 
the tubing. [NOTE: Failure to use a hydrophobic filter risks 
drawing liquids into the instrument, which will potentially 
damage the instrument.] The filter will prevent any moisture or 
debris from entering the instrument. Finally, attach a sterile 
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needle to the filter. Depending on the application, needles can 
be re-used.   
 

From the main screen, select ‘Measure’ and then the right 

arrow button. This will initiate a measurement in either mode. 

The F-920 will run either continuously (continuous mode) or 

until the minimum stable sample volume has been reached 

(trigger mode). Press the Left arrow button to return to the 

measurement screen.  

Passcode Protection 
Certain menu systems on the F-920 are protected by a passcode 

setting. These menu systems include Parameters, Set Zero, 

Calibration, and Factory Setup. The default code for entry is 

‘1111’. The passcode only needs to be entered once for each 

reboot of the device. If the device is powered off, the passcode 

will need to be entered again for entry into the menu systems 

described above.  

To set the passcode to a four-digit code other than the default 

setting, please follow the steps below. 

1. Open SD card on PC 

2. Click the ‘View’ tab in the taskbar 

3. Click ‘Options’ in the far right of the toolbar 

4. Open the ‘View’ tab 

5. Scroll down and uncheck the box named ‘Hide 

protected operating systems (Recommended)’ 

6. Check the box named ‘Show hidden files, folders, and 

drives’ 

7. Click ‘Yes’ 

8. Click ‘Apply’ and then click ‘OK’ 
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9. Open the Config.txt file that should now appear inside 

the SD card 

10. Alter the ‘1111’ to four-digit numeric passcode desired 

11. Save the changes 

12. Insert SD card back into Gas Analyzer 

Setup Menu 
Use the right arrow to enter the Setup Menu from the Main 

Menu screen. The following options are available: 

Mode 
Parameters 
Set Zero 
Calibration 
O2 Calibration in Air 
Date & Time 
GPS 
Language 
Factory Setup 

Setup > Mode 
The Mode menu contains two options: 

Measure: switches between Continuous and Trigger mode.  

Connection: switches between USB Storage (default), Bluetooth 

(enabled in future versions), or USB Ctrl (enables 

communication to controller software).  

To change, use the Up/Down arrows to cycle through the mode 

options. Press the Left arrow to exit to the main menu. 
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Setup > Parameters 
The parameters option allows the user to control the sample 

volume from 10.0 mL up to 29.9 mL when using Trigger mode. 

The default volume is 10 mL. 

Setup > Set Zero 
The set zero process sets a new baseline, or zero, for the 

sensors: 

CO2 

O2 

Set zero should take place weekly for both the Oxygen (O2) 

sensor and the Carbon Dioxide (CO2) sensor to maintain 

maximum performance. To set zero, first press the right arrow 

to select the sensor. Wait for a beep to verify the set zero 

process was completed. The set zero process requires the use of 

100% nitrogen gas for O2, and an external conditioning 

chamber full of Soda Lime to set zero for CO2. Setting zero is 

important in establishing a daily zero baseline for the sensors.  

 

Mode 

Measure             Trigger 

Connection  USB Storage 
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For the O2 sensor, an alternative calibration, O2 calibration in 

air, can be used instead of setting zero with 100% N2 gas. Please 

see the ‘O2 Calibration in Air’ section for more details on this 

process.  

The following instructions can be followed to set zero for the 

CO2 sensor: 

The F-920 is shipped with an external conditioning tube and a 

jar of Soda Lime. Fill the conditioning tube with the Soda Lime 

granules, keeping the ends packed with the cotton ball filters. 

Connect the external conditioning tube to the inlet and outlet of 

the F-920, seen below. Continue through the standard set zero 

process. The F-920 will prompt the user to use “0ppm/N2”. The 

Soda Lime external conditioning tube creates a 0 ppm CO2 

environment, alternatively, the user can connect N2 gas, which 

provides a 0 ppm CO2 environment as well. 

*The Soda Lime external conditioning tube is used for the CO2 

Set Zero process only. 
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Next, verify the set zero calibration by measuring ambient air. 
Run the set zero calibration again if the verification is not 
successful. 
 

Setup > Calibration 
The calibration feature allows the user to set zero and set span 

without the use of a computer or Gas Analysis Software (G.A.S.). 

Unlike Setup > Set Zero in the next section, a zero-standard gas 

is required as well as standard gases for the set span process. 

The F-920 Check It! Will prompt the user to set up a zero gas, 

which can be achieved by feeding 100% Nitrogen to the intake. 

The unit will countdown to set zero. The following screen will 

prompt the user to setup a span gas, which is a known standard 

gas used for the span calibration process. For more information 

on standard gases used for calibrating the Check It! Refer to the 

calibration section in the ‘Maintenance of your F-920 Check It!’ 

section. 

Setup > O2 Calibration in Air 
Alternative to setting zero for the oxygen sensor weekly with 

100% N2 gas, a user can use the O2 calibration in air menu 

option to calibrate the O2 sensor using ambient air.  

Right arrow on this menu option to begin the calibration. The 

display will read, ‘Use fresh air (20.9%) Please wait…’. The F-920 

will beep upon completion of the O2 calibration in air. 

Setup > Date and Time 
To adjust the date and time, use the Right and Left arrows to 

move between Month/Day/Year and Hour/Minute/Second and 

use the Up and Down arrows to change the values. To exit, use 
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the Left arrow to back out of the screen and return to the Setup 

menu.  

 

 

 

 

 

 

 

Setup > GPS 
The GPS sensor inside of the F-920 Check It! can be used to 

record latitude and longitude +/- 10 meters. The instrument 

should be operated outside, without overhead obstruction for 

best GPS performance. The Setup > GPS menu turns on/off the 

GPS sensor and displays the current GPS data.  Data is also 

saved to the SD card as a .csv file. 

 

 

 

 

 

 

GPS 

Enable GPS  Yes/No 

Acquiring GPS data….. 

Longitude                             122.558 

Latitude                                    45.59 

Date & Time 

MM/DD/YYYY      hh : mm : ss 

04/21/2016  17 : 01 : 43 
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Setup > Language 
The Language menu will display options for: 

English 

Spanish 

Portuguese 

Use the Up and Down arrows to select. 

Setup > Factory Setup 
The Factory Setup menu is used to: 

Restore: Restores factory defaults 

Backup:  Backs up current parameters. “Backup device’s 

                 configurations?”: NO or YES 

File Menu 
In the File Menu, the user can manipulate files on the F-920 

Check It! The F-920 will by default save to the most recently 

used file on the instrument. The file menu contains: 

Select 

Create 

Delete 

Review 

All files created by the F-920 are .csv (comma separated value) 

file extensions.  

To view data on a computer, simply insert the SD card into a 

computer’s SD card reader (always power off the F-920 before 

removing the SD card). The computer should automatically 

detect the SD card as a new storage device enabling access to 

measurement data from any computer. The mini-USB port can 
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also be used to establish a USB connection with a computer to 

transfer data from the F-920 Check It!  

File > Select 
File Select displays a list of .csv files that exist on the F-920 

Check It! SD card. Use the Up/Down arrows to move between 

files, and right arrow to select a file to which new data will be 

saved. If the unit is powered on and no file is selected, the data 

will be default saved to the file data.csv. In the file, each data 

point is labeled with time and date for easy sorting.  

 

File > Create 
Pressing the Right arrow when ‘Create’ is selected will create a 

new file according to the naming scheme programmed on the 

instrument, XX_XX_XX_X or Year_Month_Date_Ordinal. After 

pressing the right arrow, go to File > Select to see the list of files 

on the SD card. There will be a new file in the list with the 

current date.  

File > Delete 
File Delete displays a list of files that exist on the F-920 Check It! 

SD card. Use the Up/Down arrows to scroll between files and 

use the right arrow to delete the selected file. A message will 

Select 

Data . csv 

16_04_04_0 . csv 
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appear: “Delete File?” Press the Left arrow for No, leaving the 

file intact. Press the Right arrow for Yes, deleting the file.  

File > Review 
File Review displays a list of files on the SD card and allows you 

to view up to 10 of the data in the files. Use the Up/Down 

arrows to scroll between files and the right arrow to enter the 

selected file. The data.csv file is the F-920 default file used to 

store data when no other file is selected.  

After selecting a file name, the measurement mode with time of 

the measurement and gas concentration will appear for Trigger 

mode readings. Use the Up and Down arrows to highlight a 

measurement and the Right arrow to enter the measurement 

and see the more detailed data, including Date, Time, O2 and 

CO2 concentrations, Mode and Sample Volume.  

Transferring Files 
Open the saved data files on the SD card using Microsoft Excel 

or Notepad. Data files are saved as .csv file extensions (comma 

separated values). The following figure is an example data 

spreadsheet. Data values included are the date and time of the 

measurement, the measurement mode, the CO2 concentration 

in percent, the O2 concentration in percent, the temperature of 

the gas stream in degrees Celsius, the relative humidity (RH) of 

the gas stream in percent, the flow rate of the gas stream in 

milliliters (mL) per minute, and GPS data. 

Delete 

Data . csv 

16_04_04_0 . csv 
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Example spreadsheet data from an F-920 Check It!  

 

 

REMEMBER: Always save the data files to the computer before 

making changes or starting analysis. *Raw output field 

designations: Raw C2H4, Raw O2, Raw CO2, CO2 Ref, Zero 

Baseline, Temp (10x), RH (10x), Battery Voltage, Pressure (mbar) 

 

SD CARD 
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Wireless SD Memory Card Operation 
These instructions are meant to accompany the instructions 

supplied by the vendor for Toshiba FlashAir™ W-03 to use 

specifically with the F-920 Check It! Gas Analyzer, which can be 

similarly applied to other Felix Instruments products. 

1. Install FlashAir™ Wi-Fi card software appropriate to the 

SD card. 

a. Visit https://www.toshiba.co.jp/p-

media/english/download/wl/software02.htm to 

download the software for configuring the Wi-Fi 

card and obtain vendor operation instructions. 

2. Insert the Wi-Fi card onto a personal computer (PC). 

3. Open the “FlashAirTool” on your PC to configure the SD 

card. 

4. Follow the configuration instructions prompted by the 

“FlashAirTool”. 

5. For additional guidelines, access the “Help” menu inside 

the “FlashAirTool” software. 

 

https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
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6. The Wi-Fi card can be enabled in “internet pass thru 

mode”, outlined in the following documentation 

provided within the FlashAirTool software: 

• Go to Network Settings on the main menu 

Check Internet pass thru mode 

This function is available for FlashAir™ W-03 

and FlashAir™ W-02 (Ver. F19BAW3AW2.00.02 

or later) cards. 

 

When this function is enabled, the FlashAir™ 

card can be used like a router, by allowing 

another access point to be connected via the 

card. 

When an internet access point is connected, 

images stored on the FlashAir™ card can be 

viewed, and the internet can also be accessed. 

This is convenient when, for example, uploading 

image files downloaded form a FlashAir™ card 

onto social networking services, as there is no 

need to change the Wi-fi device network 

settings on your smartphone. 

 

 

* CAUTION: If you want to connect to the internet without using 

the internet pass thru mode, the wireless LAN setting 

connection on 
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your smartphone or other device must be 

changed from the FlashAir™ card to the internet 

access point. 

Check the “Enable internet pass thru mode” 

checkbox to enable “internet pass thru mode”.  

o Access Point SSID 

Sets the SSID of the internet access 

point. 

Enter the SSID for the access point that 

you will use. An SSID of up to 32 

alphanumeric characters can be 

entered. 

o Access Point Password 

Set the internet access point password. 

Enter the password for the access point 

that you will use. 

o In your browser, enter http://flashair to 

view or stream your files 

 

For more information on the Toshiba FlashAir™ W-03 Wireless 

SD Memory Card, contact the application vendor at 

https://www.toshiba.co.jp/p-media/wwsite/contact.htm, 

 

  

http://flashair/
https://www.toshiba.co.jp/p-media/wwsite/contact.htm
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F-920 Check It! Menu Map 
Below is a map of the F-920 Check It! Two Gas Analyzer menu 

system. Press the right arrow to enter a menu and the Left 

arrow to exit.  
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Gas Analysis Software (G.A.S.) 
Gas Analysis Software (G.A.S.) enables the user to not only 

calibrate the F-920 Check It!, but also view graph displays of 

measurements, download, edit and add notes to files, create 

upper and lower thresholds for quality monitoring, and 

remotely navigate through the F-920 Check It! menu system. 

A. Download the F-9x GAS_LAB_Beta.exe from 
https://felixinstruments.com/support/F-920/software/ 

B. Install 
C. Launch the program 

  
There are two ways to connect the F-920 Check It! To the Gas 
Analysis Software (G.A.S.) program: Bluetooth or USB cable 
connection.  
 

 
 

1. For USB cable connection, move ahead to step 4. For 
Bluetooth connection, on your F-920 Check It!, navigate 
to Setup > Mode > Connection > Bluetooth. On your 
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windows pc navigate to Settings > Devices > Bluetooth 
and pair your computer to the F-920 Check It!  

 

 
2. Verify that the passcode matches between the F-920 

Check It! and the computer, accept each. 

 

3. Once verified, navigate back to GAS ANALYSIS SOFTWARE 
(G.A.S.), the program will initiate a connection with the F-
920 Check It! 
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4. Once connected, your device serial number should appear 

in the upper left hand corner of the window, click on the 
serial number, you are now ready to interact with the F-
920 Check It! Click on the grey and blue square in the 
upper right hand corner to dis-connect or re-connect. 
 

 

 
Menu System 
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The following will describe the menu system functions and 
symbols: 
 

  
The ‘Files’ menu allows viewing of all files saved to the F-
920 Check It! 
 
 
The ‘Measurement Monitor’ menu displays 
measurements graphically in real time.  

 
  The ‘Control Panel’ menu displays toggle keys which 

allow the user remote control of the F-920 Check It! 

 

 The ‘Calibration’ menu navigates the user through the 

calibration process for both set zero and set span. 

 

Files   

The files menu will display all files saved to the SD card of the F-

920 Check It! 
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Just select the file of interest and choose whether to download 
the file from the device, 

 
 
Or open a saved file from your pc. 

 
  
When the document appears on the right hand column, select it 
to view and make edits in the 'Note' section. Edits can include 
deleting and making customized notations. 
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Once done reviewing and editing your data, select the save icon 
to save your changes. These changes will be saved to your pc. 

 
 
 
Measurement Monitor   
 
The Measurement Monitor menu allows the user to view a 
graphical live feed of measurements taken on the F-920 Check 
It! This feature will display the measurement mode being used, 
the selected gas, temperature, flow, and RH with the option to 
toggle between CO2, O2 and C2H4. Zoom-in and zoom-out 
display can be adjusted as well as the time interval. Left click on 
the line to see information on the data point! 
 

 



F-920 Instruction Manual rev. 5/10/2017 

 

1554 NE 3rd Ave, Camas, WA 98607, USA                               29 

Phone: (360) 833-8835   
sales@felixinstruments.com  
www.felixinstruments.com 

When Trigger mode is selected, the measurements will display 
upon completion in consecutive rows where the user can again 
edit and add notes to the data. 

 
 
Control Panel   
 
The Control Panel Menu allows the user to control the F-920 
Check It! From a computer using a series of toggle keys seen 
below. 
 

 
By pressing up or down, the user can navigate through the file 
menu to change settings on the unit and use the square button 
to take a measurement. 
 
Calibration 
   
The Calibration menu enables a two-point calibration process 
for the F-920 Check It! Including Zero Calibration and Span 
Calibration. See “Calibration” in the Maintenance section. 
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Settings 
 
The Gas Analysis Software (G.A.S.) offers a settings menu 
allowing the user to switch between continuous and trigger 
modes, as well as setting thresholds for QA monitoring. 
  

 
  
 
The user has the flexibility to create a customized validation 
profile, creating unique profile names and threshold values for 
each gas of interest, useful for quality monitoring! 
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Simply "apply validation profile" created after selecting your 
customized validation profile, and then proceed to see your 
results in the Measurement Monitor display. 
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Firmware Update 
To update the firmware on the F-920 Check It!, you will need to 

download and install the Gas Analysis Software (G.A.S.) outlined 

in the previous section. Launch the software, connect your 

device and select “Help”. 

 

 

This will reveal a menu with the option to update your 

firmware. 
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Once “Upgrade Device Firmware” is selected, the software will 

outline a series of steps for the upgrade. 

 

Follow the instructions provided in steps 1 and 2, step 3 

requires the selection of a .dfu file, which can be downloaded 

from: https://felixinstruments.com/support/F-920/software/ 

Once the file is downloaded to your computer and selected in 

step 3, click install as prompted in step 4. 

You will be prompted to wait while the firmware upgrades. 

 

Followed by a confirmation that the firmware uploaded 

successfully. Press “OK” and proceed to power on the unit by 

https://felixinstruments.com/support/F-920/software/
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pressing and holding the power button for 10 seconds. You’re 

done! 

 

Maintenance of your F-920 Check It! Gas 

Analyzer 
 

WARNING: If you plan to store this device for longer than 1 

month, follow the instructions below (Steps 1-3) on how to 

disconnect the O2 sensor from the board. This will prolong the 

life of the O2 sensor. 

 

Replacing the Oxygen (O₂) Sensor 
The oxygen sensor has a life span of one (1) year, we suggest 
sending in the unit for annual maintenance to replace 
components like the O2 sensor. The replacement of the sensor 
is simple and quick. To purchase the sensor from Felix 
Instruments contact sales@felixinstruments.com. For 
instructions to replace the sensor refer to images on the 
following page: 
 

1. Turn off the F-920 Check It! and remove the bottom 
rubber mat.  

mailto:sales@felixinstruments.com
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2. Remove the battery cap (it’s spring loaded!) and 
unscrew the black bottom plate of the F-920.  

3. Unplug the red and black cable connector by gently 
pulling the fastener out the end of the O₂ sensor. 

4. Unscrew the O2 sensor (counter-clockwise). 
5. Screw in the new sensor (clockwise) until you feel a 

resistance—not too tight! 
6. Plug in the cable connector by pressing the white 

fastener into the end of the new O2 sensor. 
7. Screw the bottom plate into position, and fasten the 

battery cap. 
8. Place the bottom rubber mat—and congratulations 

you’ve done it! 
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Calibration 
Full set span calibrations should take place annually for the CO2 

sensor and bi-annually for the O2 sensor. Always set zero before 

setting span. If you have not already done so, download the 

GAS ANALYSIS SOFTWARE (G.A.S.).exe package setup software 

from http://www.felixinstruments.com/support/F-920 and 

install it on your computer. See “Gas Analysis Software (G.A.S.)” 

section. For CO2 Calibration standard gases, we suggest 100% 

CO2 for the set span procedure and a verification gas at a lower 

value, like 20%. For O2 Calibration standard gases, we suggest 

50% O2 for the set span procedure and a verification using 

ambient air (20.9% O2). 

The GAS ANALYSIS SOFTWARE (G.A.S.) Calibration menu enables 
a two-point calibration process for the F-920 Check It! Including 
Zero Calibration and Span Calibration. 
  

 
  
  
Set zero should take place once weekly for O2 and every 6 
months for CO2 to maintain maximum performance. The set 
zero process does not require Gas Analysis Software (G.A.S.), 

http://www.felixinstruments.com/support/F-920
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see “Setup > Set Zero” section of the user manual. Set zero 
optionally CAN be done with the Gas Analysis Software (G.A.S.) 
utilizing 100% N2 gas (0% CO2 and 0% O2 gas).  
   
After setting zero, select "Span Calibration" and follow the 
instructions outlined in the software to complete the Span 
calibration process, a diagram outlining how to connect your 
standard gas will display.  

 
The timer is defaulted to 3 minutes, which is typically a 
sufficient stabilization period, if a longer stabilization period is 
needed, increase the timer to 5 minutes. Press start and wait 
for the calibration process to complete.  
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After pressing "Start", you will see the following prompt 
reminding the user of the set Zero process. 
  

 
  
If you have already completed the set zero process, press "Ok". 
Another prompt will appear asking the user to put the device in 
Continuous Monitor mode (On the F-920 Check It!: Setup > 
Mode > Measure > Continuous). Then navigate to the main 
menu and begin measuring. 
  

 
  
Press "Ok". The Gas Analysis Software (G.A.S.) will begin the 
calibration process and count down. 
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Once the calibration is completed, a green verification can be 
seen above the start button. 

 
Following step 6 of the instructions listed, you should now verify 
the calibration was successful by taking a reading of the 
standard gas used in the process. The reading should fall within 
specifications outlined on page 2-3 in the user manual. 
 
Continuous Mode Verification *After Set Span 

The following procedure is to check whether the sensors were 
calibrated to read within spec of the actual gas value. For O2, 
the specification is ±0.25% absolute and ±2% of measured 
value. For CO2, the specification is ±1% absolute and ±3% of 
measured value. 

 

 
It is highly recommended that this step be performed after 
one full day has passed since the calibration was performed. If 
this step is not performed, accuracy of the calibration cannot 
be verified. 
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Connect and read each gas and record the results here after 
three minutes (at least) of measure time. If any of the values are 
out of specification, check your procedure and recalibrate the 
sensor again. The specifications for the CO2 sensor are ±1% 
absolute and ±3% of measured value while the accuracy of the 
O2 sensor is ±0.25% absolute and ±2% of measured value. 

Gas Concentration Pass/Fail 

Air (Air is ~20.9% O2) 20.9% O2 □Yes      □No 

CO2 Verification Gas 
 

□Yes      □No 
O2 Verification Gas 

 
□Yes      □No 

 
For information on sourcing known gases required for 
calibration, please refer to the following website to inquire 
about your region: 

https://www.airliquide.com/group/where-we-operate
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FAQ 
I have a clogged probe message, what do I do? 

- The F-9xx series will display a clogged probe message 
when there is a problem with air flow. This can be 
caused potentially by a bad/saturated filter, which is 
replaceable. Additionally, check the hosing and probe 
for moisture and debris, remove the sampling probe 
and see if the clogged probe message goes away.   
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Guide for Purchasing Standardized Gases 

for Calibration 
When deciding which standard gases to purchase for 

calibration, there are some important considerations that will 

help guide your purchase: 

1) Determination of concentration of the gas to be 

purchased. The concentration of the standard gas is 

the first consideration. It needs to be at a 

concentration level that is appropriate for 

calibration of the instrument.  

 

2) Determination of proper regulator for the standard 

gas tank. A regulator is needed to provide a 

consistent flow of gas to the instrument at a certain 

rate. At our facility, we use on-demand regulators 

that require the pumps within our instruments to 

pull the gas from the standardized tank. If this is not 

an option, other regulators are acceptable, just use 

a T-junction when connecting to the instrument to 

protect the instrument from damage.  

 

3) Determination of the size of tank to order. Consider 

how many calibrations can be performed with the 

volume of gas purchased. Each calibration for the F-

920, 940, and 960 will take around 0.3 liters of 

standard gas.  

Below is an example of a standard order our company would 

make to Air Liquide for a 1.5ppm ethylene standardized gas 

tank for calibration of the F-940. 
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Air Liquide is a multi-national company that can deliver 

products to most business locations worldwide.  You may look 

at www.airliquide.com for your local office. 

Air Liquide America Specialty Gasses LLC  

Telephone 425-931-8303 or 800-814-4642 

A sample order for 34 Liter canister of appropriate calibration 

gas for an F-940 or F-950 would include the following (Note, 

these are Air Liquide’s 

unique product numbers): 

Part Number:

 A0909352

 Scotty 34 

Description: 2 

Component Mix, 

Balance Air, Gas 

34, NR 

 

 AIR 

 BAL 

 

 ETHYLENE 1.5 PPM 

Phase: Cylinder Gas Measurement: Mole Class: 

N/A 

Size: 34  

Your gas vendor will do their best to meet your specified 

concentration and will provide a certificate of analysis with your 

http://www.airliquide.com/
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gas showing what they have delivered. Be certain to use the 

actual value on the certificate of analysis as it may differ from 

what you have ordered. 

If you don’t already own a regulator, you must buy one. The 

following is the ordering information  for the on-demand style 

regulator that we typically use. (Note, these are Air Liquide’s 

unique product numbers) 

Part Number: A0315576 

Description: Q114DRFRC10 – M14 Demand 

Regulator 

0 – 3 LPM @ 3’ 
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Warranty Information 
 
Seller's Warranty and Liability: 
  
Felix Instruments- Applied Food Science warrants new 
equipment of its own manufacturing against defective 
workmanship and materials for a period of one year from date 
of sale. The results of ordinary wear and tear, neglect, misuse, 
accident and excessive deterioration due to corrosion from any 
cause is not to be considered a defect.  
Felix Instruments’ liability for repairing or replacing defective 
parts during the warranty period is contingent on examination 
by a Felix Instruments authorized representative. Felix 
Instruments liability will not extend beyond repairing or 
replacing parts from the factory where they were originally 
manufactured. Repair or alteration by an unauthorized 
technician voids warranty.  
Material and equipment which is not manufactured by Felix 
Instruments is to be covered only by the warranty of its 
manufacturer. Felix Instruments will not be liable to the Buyer 
for loss, damage, or injury to persons or to property by the use 
of equipment manufactured by other companies.  
 
 
Buyer accepts the terms of warranty through use of this 
instrument and any accessory equipment. There are no 
understandings, representations, or warranties of any kind, 
express, implied, statutory, or otherwise (including, but without 
limitation, the implied warranties of merchantability and fitness 
for a particular purpose), not expressly set forth herein. 
 
 
All instrument repairs or replacement covered under warranty 
require a Returned Material Authorization (RMA) number. 
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Please contact Felix Instruments technical support department 
at support@felixinstruments.com to obtain an RMA number 
before shipping instrument to CID Bio-Science, Inc.  
 
Buyer is responsible for shipping charges to Felix Instruments 
headquarters: 
 
1554 NE 3rd Ave. 
Camas, WA 98607 
USA 
 
 
Felix Instruments is responsible for return shipping charges on 
repairs and/or replacement covered by warranty.   
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Warranty Registration Card 

 
1554 NE 3rd Ave, Camas, WA 98607, USA 
Phone: (360) 833-8835  Fax: (360) 833-1914  e-mail: sales@felixinstruments.com Web: www.felixinstruments.com 
  

PRODUCT REGISTRATION CARD 

Please complete and return this form to Felix Instruments within 30 days to validate your Warranty on Parts & Labor. 
    
Registration Information: 
  

Your Name:____________________________________ Title:__________________ 

Company/University:___________________________________________________ 

Address:_____________________________________________________________  

City:____________________________ State:__________ Zip:__________________ 

Country:__________________________Email_______________________________ 

Phone:______________________________ Fax:____________________________ 

Felix Instruments Serial Number(s):__________________________________________________  

Purchase Date:_____________________Purchase Price:_____________________  

------------------------------------------------------------------------------------------------------------------ 
FOLD ON DOTTED LINE 

   
  
Your opinions will help improve our service. Please answer the following questions. 
 
1. What was the basis of your product selection? 
□ Representative Recommendation    □ Price 
□ Product Features     □ Product Design 
□ Technical Specifications     □ Brand Name 
□ Warranty       □ Service 
□ Other _________________________________________ 
 
2.  What other competing brands did you consider? __________________________ 
 
3. Where did you first learn of this product? 
□ Advertisement in ________________________________   □ Representative 
□ Friend/Colleague     □ Exhibit 
□ Other _________________________________________ 
 
4. Who selected this product? 
□ I did      □ Research Group 
□ University Department     □ Purchasing 
□ Other _________________________________________ 
 
5. Comments/Suggestions:  
______________________________________________________________________ 
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F-920 Production Test Check Sheet 

SERIAL NUMBER:  

Firmware Version:  

 

 

 

 

 

 

NOTES:                                                                                                       

 

 


